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Copyright and Proprietary Notice

Proprietary Notice and Disclaimer

The information herein disclosed is the property of iCRco., Inc. Information in this document is subject to change
without notice and does not represent a commitment by iCRco to incorporate changes or improvements in units
previously sold or shipped. No part of this document may be reproduced or transmitted in any form, electronic or
mechanical, including photocopying and recording, for any purpose other than the purchaser's own use without the
express written permission of iCRco.

Copyright
Copyright© iCRco Inc. 2003-2014. All rights reserved.

Trademarks

iCR 1000™, iCR 1000 Dual™, iCR 2600™, iCR 2600 Dual™, iCR 2600SF™, iCR Vet™, iCR Vet Dual™, iCR
Mobile™, iCR 1-D™, iCR Chiro™, iCR Chiro Dual™, iCR 3600™, iCR 3600SF™, iCR VERTX™, iDR™, Fusion
DCR™, Chrome™, Chrome Duo™, Air DR™, Air DRc™, Fusion DR Mobile™, QPC XSCAN32™, Captera™, XC™,
and www . icrco.com are the trademarks of iCRco. All other trademarks are the property of their respective owners,
and are hereby acknowledged.

Terms

Any one of the following iCR products will be referred to as the "CR unit" throughout this document: iCR Vet™, iCR
Vet Dual™, iCR Mobile™, iCR 1-D™, iCR Chiro™, iCR Chiro Dual™, iCR 3600™, iCR 3600SF™, iCR VERTX™,
iCR Fusion™, Chrome™, Chrome Duo™.

Any one of the following iCR products will be referred to as "DR unit" throughout this document: Air DR™, Air
DRc™.

Any one of the following iCR products will be referred to as "iCR desktop unit" throughout this document: iCR
VERTX™. The iDR™ and Fusion DR Mobile™ will be referred to as the "DR unit" throughout this document.
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Contact and Product Information

Contact Information

iCRco., Inc. Americas

Address: 2580 West 237" Street, Torrance, CA, 90505

Phone: +1.310.921.9559

Fax: +1.310.542.7236

Email: info@icrcompany.com

Web: http://www.icrco.com

iCRco., Inc. Europe

Address: Paderborner Str. 21, 44143 Dortmund, Germany

Phone: +49.231.92733669

iCRco., Inc. Middle East/India

Address: 1st Floor, Manohar Varsha, Y-7, Green Park (Main),
New Delhi-110016

Phone: +011-40522979

Information

Please enter the details of the system here:

Serial Number:

Date Purchased:

Interface Type: USB 2.0
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Safety Information

Read and understand the installation and operating instructions before starting the software.

[ | =C | REF C € ooss

US Headquarters European Office

ICRco, Inc. ICRco Europe GmbH

2580 West 237th Street  Paderborner Str. 21 AFDA q
Torrance, CA 90505 44143 Dortmund SR
USA Germany

310-921-9559 +49-231-92733669

Conventions

=
' Ty

e

Warning:

A WARNING indicates a potentially hazardous situation which, if not avoided, could result in death or
serious injury.

Caution:

A CAUTION indicates a potentially hazardous situation which, if not avoided, may result in minor or
moderate injury. It may also be used to alert against unsafe practices.

Note:
A NOTE indicates important information that helps you better utilize your CR Unit and Software.
Important:

An IMPORTANT indicates either potential damage to hardware or loss of data and tells you how to avoid the
problem.

Malfunctioning Equipment

If any iCRco software product shows signs of malfunction, try restarting the computer; if the problem persists or is
reproducible discontinue the use of the product immediately and contact Technical Support at 310-921-9559.
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ICRco Warranty

iCRco, Inc. ("iCRco") values your business and always strives to provide high-quality products and services. All
iCRco products are provided with an initial warranty so that the hardware and software are covered from the date

of purchase. This limited warranty solely applies to new products manufactured by or for iCRco and originally
purchased from iCRco or an authorized dealer of iCRco products for your own use. In addition, an extended warranty
is available for most new and recently purchased iCRco products for an additional charge.

Hardware Limited Warranty

iCRco warrants its hardware products to be free of defects in materials and workmanship for a period of one (1) year
from the date of original shipment from iCRco subject to the limitations set forth herein. If a product proves to be
defective in material or workmanship during the warranty period, iCRco will, at its sole option, repair or replace the
product with a similar product. Repaired and replacement products may be or include refurbished or remanufactured
parts. Any replacement item assumes the remaining warranty period of the original product. iCRco provides no
warranty for any third party hardware or software included with any product or later acquired.

Software Limited Warranty/Support

iCRco warrants that its QPC XSCAN32, Captera, XC, and/or Clarity PACS software originally provided with
any product will substantially conform to iCRco's specifications and that the media, not including hard drives, on
which the software is furnished will be free from defects in materials and workmanship under normal use for a
period of one (1) year from the date of original shipment from iCRco. iCRco's sole obligation under this warranty
is limited to making reasonable efforts to ensure such conformity and to supply the consumer with a corrected
version of the software as soon as it is practical after the consumer has notified iCRco of any nonconformity. iCRco
does not warrant that the operation of any software will be uninterruptible, glitch- or error-free, or that functions
contained in the software will operate in the combinations which may be selected for use by the user or meet the
user's requirements. This limited software warranty will be void if the software is modified without the written
approval of iCRco or is used outside of the recommended parameters or equipment. iCRco does not provide any
warranty or support for any other software.

iCRco agrees to provide one (1) year of telephonic and/or e-mail-based support for QPC XSCAN32, Captera, XC,
and/or Clarity PACS software originally provided with any new iCRco product from the date of original shipment
from iCRco . All software support shall be limited to making reasonable efforts to resolve iCRco software issues

and shall be limited to iCRco's regular business hours. In addition, iCRco will provide revisions and upgrades to its
software upon request (when available) during the first year after the software was originally shipped from the iCRco
factory. The initial support period will include support via remote login software, only if the customer has access to
the Internet from that PC and only if the customer agrees iCRco shall have no liability in connection with its support
efforts. Remote login software allows iCRco technical support to remotely access the customer's PC via the Internet
for the purposes of rendering technical support. Please note that this warranty, including software support, does not
include computer hardware, third party software, or operating system or network issues, which are outside the control
of iCRco.

Warranty Product Technical Requirements

iCRco requires that all DR, CR, Scanner, and/or products requiring PCs be fitted and installed with a 1300VA
(780W) uninterruptible power supply ("UPS"). iCRco recommends the APC 1300 specification UPS or equivalent.
For warranty evaluation and service, iCRco requires the customer to provide an Internet connection (DSL or Dial-
up) or the minimum of a phone line accessible by an extension cord to the product enabling iCRco technicians to
perform remote diagnostics on installed equipment. In addition, each iCRco product must be installed, maintained,
and operated in accordance with the respective product manual. Failure to comply with these requirements will result
in a voided warranty claim.
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Requesting Warranty Service

For information on obtaining warranty service, call iCRco's customer support at (310) 921-9559. In order to evaluate
a warranty service request, iCRco requires the following information: the iCRco serial number of the product,

a detailed description of the problem, customer name and contact information, product location and operating
conditions, a copy of the purchase documents, and sufficient information and authorization, including a liability
release as to any loss of data (that should always be backed up), software or network injury, or downtime, allowing
iCRco technicians remote access to the product. Product may not be returned to iCRco without first obtaining a
Return Material Authorization ("RMA") number from iCRco . Prior to providing an RMA, iCRco may require remote
access to the product. If iCRco determines that the product may be defective, is under warranty, and necessitates a
return to iCRco for service, an RMA number and instructions for return of the product will be given. iCRco is not
responsible for any unauthorized returned product, i.e. one for which an RMA number has not been issued by iCRco.

Warranty service requires all authorized returns be shipped to the iCRco factory prepaid and insured. All such
authorized returns are the customer's responsibility. For products sold and located within the United States, iCRco will
pay for return shipping.

Products being returned are only to be shipped in iCRco approved shipping containers. The original box and
packaging materials are approved and should be kept for moving and/or shipping the product. Approved packaging
may also be purchased from iCRco for an additional charge. iCRco shall have no liability nor responsibility for
warranty service to any product that is not shipped in an iCRco approved shipping container, that is damaged from
incorrect packaging, or that is damaged during shipping.

Additional Warranty Limitations and Extent of Warranty

This warranty does not apply if the product has been damaged by accident, misuse, or abuse. In addition, warranty
service does not include the repair of failures or defects caused by: unauthorized attachments to any iCRco product,
unsuitable physical or operating environment, maintenance or repair by anyone other than iCRco or the iCRco
authorized dealer that sold the product, operation of a product beyond its duty cycle, use of the product outside of its
specifications, the use of supplies, parts, materials, software, or interfaces not furnished, authorized, or recommended
by iCRco . If the product, including any software has been opened, tampered with, modified, or altered in any way
without written authorization by iCRco, the warranty will no longer apply.

This warranty applies only to products manufactured by, or for, iCRco; products can be identified by an "iCRco"
serial number as originally affixed to the product. Any modification to the iCRco serial number tag or its attachment
to the product shall immediately void the warranty.

This warranty is non-transferable and subsequent owners must contact iCRco to establish if the equipment is eligible
for an extended warranty.

THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO ANY iCRco PRODUCT
OTHER THAN AS SPECIFICALLY SET FORTH HEREIN, AND iCRco SPECIFICALLY DISCLAIMS ANY
IMPLIED WARRANTIES OR CONDITIONS OF MERCHANT ABILITY, FITNESS FOR A PARTICULAR
PURPOSE, AND SATISFACTORY QUALITY. ANY WARRANTIES THAT MAY NOT BE DISCLAIMED
UNDER APPLICABLE LAW ARE LIMITED IN DURATION TO THE INITIAL WARRANTY PERIOD AND
NO WARRANTIES, EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. ALL INFORMATION,
SPECIFICATIONS, PRICES, AND SERVICES ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT
NOTICE.

Limitation of Remedies and Liability/Exclusion of Damages

The exclusive remedy for any defective product is limited to the repair or replacement of the defective product. iCRco
shall have a reasonable time after determining that a defective product exists to repair or replace a defective product.
iCRco's entire liability for any product is limited to the actual purchase price for the product. This limitation applies
even if iCRco cannot or does not repair or replace any defective product.

IN NO EVENT WILL iCRco BE LIABLE FOR ANY GENERAL, SPECIAL, CONSEQUENTIAL, OR
INCIDENTAL DAMAGES, including but not limited to, damages related to the loss of use, loss of recorded product,
the installation of replacement product, or any inspection, testing, or redesign caused by defect or by the repair or
replacement of any product arising from a defect in any product. This exclusion of damages applies even if the
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customer advises iCRco or an iCRco dealer of the possibility of such damages. This limitation of remedies also
applies to claims against any suppliers or dealers of iCRco. iCRco and its suppliers' and dealers' limitations of
remedies are not cumulative. Such suppliers and dealers are intended beneficiaries of this limitation. iCRco is not
liable for any claim by or against the customer arising from a third party claim.
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Chapter

1

System Requirements and Initial Configuration

XC System Requirements

Minimum Hardware Requirements

* Intel Core i3 CPU or greater
* 4 GB RAM or greater
» 7200 RPM Disk with >500GB

Software Requirements

Genuine Microsoft Windows Operating System:

*  Windows XP SP3 (32- or 64-bit)
*  Windows 7 (32- or 64-bit)
*  Windows 8 (32- or 64-bit)

with Microsoft .Net 4.x

Initial Configuration

Verifying the Region, Locale, Date, and Time

1. Go to Start > Control Panel > Date and Time

2. Ensure the date, time, and time zone are accurate for your region.
3. Go to Start > Control Panel > Region and Language > Location
4. Ensure the Current Location is accurate for your region.

Setting the Administrative Account

The first time the application is run you will be prompted to Create An Administrative Account. Enter the desired
username and password for the Administrative Account. Have the clinical administrator write the Administrative
username and password down. Store the password somewhere where it will be safe.

When the administrative account is successfully created, the Login dialog will appear. Login with the Administrative

Account.

Note:

If the Administrative Account is not created, XC will not launch.

Verifying the Application is not in Demo Mode

1. Click the Configuration button on the Patient Worklist screen.

2. Select the Device Settings tab.

© 2003-2014
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3. Under Demo Settings, the Enable Demo CR button should be set to Off.
4. Sclect the Close and Accept button to confirm changes.

Setting the Scan Resolution
Note:

If your facility is mandated by law to acquire with a specific resolution, then disregard the information in this
section. These instructions are not a mandate to acquire at a specific resolution.

Click the Configuration button on the Patient Worklist screen.

Select the Device Settings tab.

Select the desired device.

Select the desired cassette size.

For general radiography, scan resolution of 155 microns and 200 microns are the recommended setting.
Click Close and Accept to save the changes.

AN I

Setting the Appropriate Language

1. Click the Configuration button on the Patient Worklist screen.
Select the Settings tab.
Under Language select the desired language.

Eal o

Select the Close and Accept button to confirm changes.

Setting the Imaging Domain

The Imaging Domain determines the default anatomy available for selection. The default can be toggled at scan time
by clicking the imaging domain button on the Anatomy Selection screen. For example, if the site does mammography,
the Mammography imaging domain needs to be set.

This setting can only be modified by the Administrative Account.

1. Click the Configuration button on the Patient Worklist screen.

2. Seclect the Admin > Settings tab.

3. Under Imaging Domain select the correct domain from the drop-down menu.
4. Select the Close and Accept button to confirm changes.

Setting the Processing Parameters Library

The processing parameters library enable different groups of processing presets. This setting generally does not need
to be changed. Altering the settings can result in poor image processing.

This setting can only be modified by the Administrative Account. To evaluate or adjust the Processing Parameters, see
Section Processing Parameter Evaluation on page 90 for more information.

To set the new library:

1. Click the Configuration button on the Patient Worklist screen.
2. On the Admin > Settings tab under Imaging Domain, click the Launch Applications Interface button.

The Applications Interface will open.

Click the down arrow of the Library File combo box.
Select the name of the new file.

Click the Save Repository To Disk button.

Close the Applications Interface.

Select the Close and Accept button to confirm the changes.

AR A o

© 2003-2014 Page 18 of 100 Doc # HC-XC-0028-05 Rev E-02
Confidential and Proprietary February 26, 2014
Property of iCRco, Inc.



| System Requirements and Initial Configuration | 19

Setting up DICOM Targets

1. Click the Configuration button on the Patient Worklist screen.

2. Select the DICOM tab.
3. Add a DICOM target by clicking the Add New AET button.
4. Enter or choose the following information on the Add DICOM AET screen:
Field Value
Target Name What you want to call it
Target AET Title Applications Entity Title of the target application
IP Address The IP Address of the target application
TCP Port The DICOM receive port of the target application. 104
is the default port.
Modality The DICOM tag the sending images should be
identified as.
Target Type The annotation type the sending images contains.

Graphics Object is the newest, followed by Overlay,
then Embed. If you can't see annotations at the target
application, change this setting.

For Processing Enable if the target application is going to do image
processing. For example, a dedicated Mammographic
CAD application. This sends the image from XC
without processing it.

XScan QPC Enable only if sending to the QPC XSCAN32
application.

5. Select the Finish button.
6. Click the Close and Accept button to confirm the changes.

Setting Auto-Send Targets
The auto-send targets feature will DICOM Send an image to a predefined target. Enable the feature as follows:

Create a DICOM target as covered in Setting up DICOM Targets on page 19.
Click the Configuration button on the Patient Worklist screen.

Select the DICOM tab.

Select the Auto Send Targets tab.

Select the target(s) the user would like to automatically send their images to by placing a check mark in the check
box.

6. Select the Close and Accept button to confirm changes.

R W

When the Accept and Send button is clicked at the Image widow, the image will send to the specified targets.

Setting Worklist Targets
If you need XC to query a DICOM modality worklist, the feature can be enabled as follows:

Create a DICOM target as covered in Setting up DICOM Targets on page 19.
Click the Configuration button on the Patient Worklist screen.

Select the DICOM tab.

Select the Worklist Inputs tab.

Select the target(s) whose DICOM MWL the user would like to query.

Select the interval for the automatic query and any desired search constraints.

SNk W=
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7. Select the Close and Accept button to confirm changes.

Setting the Institution Address

1. Click the Configuration button on the Patient Worklist screen.
2. Select Defaults tab.

3. Enter the address in the Institution Address ficld.

4. Click Close and Accept to save the changes.

Setting the Default Referring Physician

=

Click the Configuration button on the Patient Worklist screen.

Select Defaults tab.

In the Referring Physician box, click Add.

Enter the Referring Physician's name, then click Finish.

Put a check in the box next to the default Referring Physician's name, then click Set.

Nk wN

The default Referring Physician is set.
6. Click Close and Accept to save the changes.

Setting the Institution Name

1. Click the Configuration button on the Patient Worklist screen.

Select Defaults tab.

In the Institution box, click Add.

Enter the Institution name, then click Finish.

Put a check in the box next to the default Institution name, then click Set.

A

The dealt Institution name is set.
6. Click Close and Accept to save the changes.

OPTIONAL: Enable the X-ray Generator Interface

1. Click the Configuration button on the Patient Worklist screen.
Select Device Settings tab, then X-Ray Tubes tab.
Select the correct X-ray generator from the drop down list labeled Attached X-ray Tube.

Eal ol

Select the Close and Accept button to confirm changes.

OPTIONAL: Disabling Log-In Requirement

Note:
[ |

Disabling the log-in should only be performed if specifically required by the site administrator.

Click the Configuration button on the Patient Worklist screen.
Select the Admin tab, then the Users tab.
Under Require Login select the Off button.

Pl ol S

Select the Close and Accept button to confirm the changes.
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Launching, Logging In and Out, and Quitting

User Manual

This manual covers information related to the XC software.

For information regarding a specific product, please read that product's user manual.

Logging In (Administrator Account)

After running the Installer, the User should double-click on the XC short-cut on the desktop to open XC.

Note:
The first User account created is the administrator account. The administrator account is able to access the
program configuration dialog, create new Users, grant User privileges, and quit the application. For more
information, see the Section Configuration on page 73

Logging In

1. In the User Login dialog, enter a User name and password.
Note:

Alternatively, the User may select from a drop-down list of previously entered User names by clicking the
drop-down menu on the right-hand side of the User name text field.

2. Click Log In to log in.

Figure 1: XC's User Login Screen
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Logging Out, Quitting, and Worklist Commands

The user can log out of XC from the Worklist screen by clicking the Log Out button. @

(er
The user can quit XC from the Worklist screen by clicking the Quit button. @

The user can launch the default web browser from the Worklist screen by clicking the Web Browser button. &

The user can condition (deep erase) a loaded cassette from the Worklist screen by clicking the Condition button. @
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Acquiring an Image

Manual Imaging Workflow

The following steps represent a generalized workflow and are meant to walk the user through using XC. Every
workflow varies in process.

1. In the Patient List window, click Schedule Patient.

@ XC

MName SMITH, DIANA

MName: Test, Caplera 1090005

2. Enter the patient and study information, then click Finish and Scan.

Note:
0 . : . :
Before you can proceed to the next step, you must input the Patient ID, Last Name, Birth Date, Referring
Physician, and Institution. If you are limited in time, you can check the Reconcile Later box, which will
only require you to input the Patient ID and Last Name.
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3. Select the region (and if necessary, laterality) of the anatomy by clicking on the appropriate body region, then
select the anatomy and view by clicking on the appropriate buttons.

' Selected View: Chest PA Portrait

Chrome

Deep Erase

High
Resolution

5. As the image is acquired, it will be displayed in the Image Display window.
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Scanning.

6. When the image is finished scanning, make the desired manipulations and annotations. All XC manipulation and
annotation tools are selected in the Tools Menu Bar on the left side of the Image Display window. The Window/
Level, Zoom, Pan, Zoom, and Crop tools are shown in the graphic below.

7. When the User is finished manipulating the image, click the Accept and Send button in the lower, left-hand
corner of the Image Display window. When the Accept and Send button is clicked, it will save the current image
manipulations and DICOM Send the image.

Note:

If DICOM auto-send is not enabled, the "Accept and Send" button will read "Accept." The Accept button
will save current manipulations to the image, but will not DICOM Send.
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Processing Complete.

8. OPTIONAL: To add another View to the study, click Add View.

Procedure-based Imaging Workflow

The Imaging Procedure Type provides the user with a template for ordering a sequence of scans for a particular study.
The user is allowed to create their own Imaging Procedure Type in which they can specify the ordering sequence of
each scan and the scan parameters.

Note:

For North American users, XC provides the user with a default set of Imaging Procedure Type that is
associated with its respective CPT code.

Acquiring an Image for Imaging Procedure for a new patient.

1. In the Patient List Window click the Schedule Patient. This will open the Schedule Patient Window.

2. Enter the patient information in the Patient Info box.
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Click Procedure, then select the desired procedure.

Click Finish and Scan. The Scan dialog will open.

Sehedute Patient e

~
- Patsent ko =

(<l o

k 2
L N o} o | o J

3. If necessary, select the laterality.

Click the cassette size button to initiate a scan.

— Laterality

Deep Erase I

High
Resolution

14 x 17 inches

5. If it is a multi-view procedure, select the next procedure from the thumbnail. The Image Procedure is completed
when all the scans are acquired.
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Acquiring an Image for Imaging Procedure for existing patient.

1. In the Patient List Window open the desired patient's Patient Information Bar. This will open the Study
Information Window.

2. Create a new study by clicking the Schedule New Study button.

3. Enter the patient information on the Schedule New Study Window. Click the box called Procedure, a drop-down
menu will show up and select the desired procedure.

Then click the Finish and Scan button. This will open the Studies window.

In the Study Information Window the Study Thumbnail Gallery is preloaded with a series of scan orders and each
thumbnail displays information of the anatomy view.

Click on the thumbnail and this will open the Scanner Option window
Select an appropriate cassette size for acquiring an image.

n =

As the image is acquired, it will be displayed in the Image Display window.
Imaging Procedure is completed when all the scans are acquired.

© P

Patient Information Reconciliation Imaging Workflow

The Patient Information Reconciliation feature allows the user to enter patient demographic information after all of
the images have been obtained.

In particular, this feature is useful for handling unindentified or emergency patients.
Note:

The Patient Information Reconciliation feature works as an extension of the general imaging workflow or the
procedure-based imaging workflow.

The following steps represent a generalize workflow on how the user can utilize the Patient Information Reconcilation
feature for acquiring an image for an unidentified patient.

1. In the Patient List window, click Schedule Patient.

@ XC

2. Enter known patient and study information, then check the Reconcile Button checkbox. Click Finish and Scan.
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3. Select the region (and if necessary, laterality) of the anatomy by clicking on the appropriate body region, then
select the anatomy and view by clicking on the appropriate buttons.

' Selected View: Chest PA Portrait

Chrome

Deep Erase

High
Resolution

5. As the image is acquired, it will be displayed in the Image Display window.
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Scanning.

6. To reconcile the study, go to to the Study Information window and click the Study Information Bar.

Stulies -

7. If the study was marked for Reconcile Later, a button labeled Reconcile will appear. Click the Reconcile button.

Edit Study -
e ™

= Pablera s

P e
= Sty iy

. T .

— - » - “ ==

e s [~ I

==

8. A worklist query dialog box will be displayed. Select the desired entery and click the Use Selected to confirm a

selection.
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Description Patient D Accession #

Ring”Lynsey"R*" X-Ray 72100 - Lumbasacral Spine, Limited RINLY00D 22996 7/13/2012 11:54

Ring”Lynsey"R™" X-Ray 72220 - Sacrum, Coccyx RINLY0CO 22997 7/13/2012 11:5]

Batista*Jog JA A4 50003 1234003 9/27/2010 1.01

Lim A RICK-984 4~ 900199 123400992 242172011 1.014

Use Selected Cancel

9. A confirmation dialog will appear. Click Yes to complete the reconcilation procedure.

Are you sure you would like to reconcile this
study and patient?

10. XC will automatically update the displayed study and patient information and the workflow is completed.

Auto Scan Workflow

The following steps represent a generalized workflow utilizing the Auto Scan functionality.
To set XC to Auto Scan mode, see Section Auto Scan Mode on page 80
Note:

Auto Scan mode can only be used with Chrome and Chrome Duo units.

1. In the Patient List window, click Schedule Patient.
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MName SMITH, DIANA

3. Select the scheduled study. This will bring up the Study Overview.
4. Insert a cassette into a bay. This will bring up the Device Overview dialog. The scan unit will begin scanning the
cassette.

Note: Clicking the Add View button will also bring up the Device Overview dialog.
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5. The Device Overview informs you of the status of the bay(s). While the cassette is scanning, select the anatomy,
laterality, and view of the image being scanned.

“Studies S

Note: If the scan unit has two bays, it's possible to scan two cassettes at the same time. To start a second
| scan using the other bay, insert the cassette into the available bay. Select the image information while the
cassette is scanning.

Note: Click the image being scanned to view the image in the Image Display window.
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6. Click OK to close the Device Overview dialog. The Image Display window will appear, showing all of the
acquired images.

Note: The images will automatically arrange themselves, displaying a maximum of four images at the
| same time.

7. When the image(s) is finished scanning, make the desired manipulations and annotations. All XC manipulation
and annotation tools are selected in the Tools Menu Bar on the left side of the Image Display window. The
Window/Level, Zoom, Pan, and Crop tools are shown in the graphic below.

When finished manipulating the image, click the Accept and Send button in the lower, left-hand corner of

the Image Display window. When the Accept and Send button is clicked, it will save the current image
manipulations and DICOM Send the image.

Note:

If DICOM auto-send is not enabled, the "Accept and Send" button will read "Accept." The Accept button
will save current manipulations to the image, but will not DICOM Send.
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Barcode Scan Workflow

The following steps represent a generalized workflow utilizing the Barcode Scan functionality.

To set XC to Barcode Scan mode, see Section Barcode Scan Mode on page 81

- Note:
Barcode Mode requires a handheld barcode reader.
Note:

|

Barcode Scan mode can only be used with Chrome and Chrome Duo units.

1. In Barcode mode, cassette barcodes must first be registered to XC before they can be scanned. This usually occurs
prior to exposure, but can be done at any point before image acquisition.

2. To register a cassette, go to the Patient List window, and click Schedule Patient.
@XC" e @ @
T . S S S CH - CR

-

DOB:8/11/1964
Paysician: Dr C

3. Enter the patient and study information, then click Finish.
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4. Select the scheduled study. This will bring up the Study Overview.

5. Click the Cassette registration button to open the Cassette registration window.

6. Select the region of the anatomy by clicking on the appropriate body region, then select the laterality and view.

Fassatia registration st tect - 10004 e

Note: The Cassette registration window will list all cassettes that are currently registered.

|
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7. Using a barcode reader, scan the cassette's barcode. This will register the cassette to the selected patient and
anatomy. When a cassette is successfully registered, it will appear in the registered cassette list.

Note: To register another cassette, select the anatomy, laterality, and view, and then scan the cassette's
[ barcode.

L Note: If you register a cassette that's already registered, XC will ask if you want to re-register the
- cassette.

Note: Sclecting a registered cassette in the list will highlight the selected anatomy on the screen.
Cassettes registered to different patients will be greyed out and inaccessible.

8. When finished registering cassettes, click the Finish Registration button.

Note: Images cannot be scanned while in the Cassette registration window.

9. After the registered cassette(s) has been exposed, scan the cassette's barcode. XC will notify you that it's ""Ready
to Scan".

10. Insert the cassette into the bay to begin image acquisition.

Note: If the scan unit has two bays, it's possible to scan two cassettes at the same time. To start a second
scan using the other bay, scan the barcode of another cassette, and then insert the cassette into the
available bay.
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Soucline - oRTT— L

Scanning...

11. Click OK to close the Device Overview dialog. The Image Display window will appear, showing all of the
acquired images.

Note: The images will automatically arrange themselves, displaying a maximum of four images at the
same time.
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12. When the image(s) is finished scanning, make the desired manipulations and annotations. All XC manipulation
and annotation tools are selected in the Tools Menu Bar on the left side of the Image Display window. The
Window/Level, Zoom, Pan, and Crop tools are shown in the graphic below.

13. When finished manipulating the image, click the Accept and Send button in the lower, left-hand corner of
the Image Display window. When the Accept and Send button is clicked, it will save the current image
manipulations and DICOM Send the image.

Note:

If DICOM auto-send is not enabled, the "Accept and Send" button will read "Accept." The Accept button
will save current manipulations to the image, but will not DICOM Send.
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Tools and Processing

Image Manipulation Tools

All XC image processing, manipulation, and annotation tools are selected in the Tools Menu Bar on the left side of
the Image Display window.

Window/Level

a "

o

The Window/Level tool allows the User to adjust the brightness and contrast of the image. To use the Window/Level
tool, first select it from the pop-up menu on the left-hand side of the screen. Then move the mouse over the image.
Moving the mouse vertically while holding down the mouse button will adjust the brightness, while moving the
mouse horizontally will adjust the contrast.

Smart Box Window/Level
]
L]

4

The Smart Box Window/Level tool allows the User to automatically adjust the brightness and contrast of the image
with a user-selectable box. The optimal window/level settings will be determined by the user-defined selection. To
use the Smart Box Window/Level tool, first select it from the pop-up menu on the left-hand side of the screen. Then
mouse click and drag until the Smart Box is the desired size. Upon releasing the mouse button, the Window/Level
setting will be automatically calculated. The User may resize the box at any time by selecting the Smart Box by one
of the corners, and dragging to the desired size. The User may also move the Smart Box around the image to yield
different Window/Level settings by clicking and dragging from the middle of the Smart Box. To hide the Smart Box
and apply the settings, click the Smart Box button in the tool bar. The User may re-draw the Smart Box at any time by
deselecting then re-initiating the tool.

Zoom

The Zoom tool allows the User to alter the on-screen magnification level of the image. To use the Zoom tool, first
select it from the pop-up menu on the left-hand side of the screen. Then move the mouse cursor over the image and
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move towards the top of the image to increase the zoom level, or towards the bottom of the image to decrease the
zoom level.

Synchronized Zoom

The Synchronized Zoom tool allows the User to match magification levels when viewing multiple images side by side
in multie-tile mode. In multi-tile mode, the currently selected image in the group is highlighted. When you select this
tool, all other images will magnify to the same level of magnification as the highlighted image. Additionally, when
this tool is selected, any magnification changes on the highlighted image will also modify the magnification level of
all other images.

Pan
Fa S Y

L r

The Pan tool allows the User to move the image to different positions on the screen. To use the Pan tool, first select
it from the pop-up menu on the left-hand side of the screen. Then click and drag the image until the desired region is
visible.

Magnify
. I_D_I_J.

The Magnify tool provides a small window that displays a region of the image at increased magnification. To use
the Magnify tool, first select it from the pop-up menu on the left-hand side of the screen. Move the mouse over the
desired region of interest, then click and hold the mouse button, and the region of interest will be magnified. While
holding the mouse button, the User may drag the magnified box to different areas of the image.

Image Invert

T Ty
r 1qﬁ
H—-}\_

The Invert Image tool allows the User to transpose the image data (invert black/white). To use the Image Invert tool,
first select it from the pop-up men on the left-hand side of the screen. Then click the Image Invert button. The image
data will be inverted.

Rotate Clockwise and Counter-Clockwise
A | ¢\
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The Rotate tools allow the User to rotate the image in 90° increments. To use the Rotate tools, first open the pop-up
menu on the left-hand side of the screen. Then click either Rotate Clockwise or Rotate Counter-Clockwise until the
desired rotation is achieved. A single mouse click on the Clockwise or Counter-clockwise button will rotate the image
90°.

f - '.\ll e m-\h
The Flip tools allow the User to invert the image, either horizontally or vertically. To use the Flip tools, first open the

pop-up menu on the left-hand side of the screen. Then click either Flip Vertical or Flip Horizontal until the desired
orientation is achieved.

Flip Vertical and Horizontal

Crop

L e

The Crop tools allows the User to discard unwanted information around the edges of the image (usually collimation).
When the crop is confirmed, the image is copied, then cropped, resulting in the new, cropped image. Additionally, the
image can be reprocessed after being cropped.

Note:
Mammography images cannot be cropped.
To use the Crop tool:

1. Select the Crop tool from the menu on the left-hand side of the screen.
2. Click, hold, and drag the box to the desired size.
3. Click the Confirm button to apply the crop.

The image is cropped.

Predefined Crop

The Predefined Crop tool allows the user to discard unwanted information around the edges of the image, similar to
the Crop tool. Selecting the tool allows you to select a specified crop size entered into the scan software beforehand.
This will create a crop box that can be dragged and repositioned. When satisifed with the crop position, the user can
select Confirm. The user also has the option of reprocessing the image after it is cropped.

Note:

The user can set crop sizes in Configuration. See Predefined Crop Boxes on page 81.
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Image Masking Tool

The Image Masking tool allows the User to hide any collimation or undesired artifacts around an image without
discarding image data.

Note: The way the mask is embedded in the DICOM file depends on the Target Type setting Edit AET
screen located at Configuration > DICOM. If the mask does not show up when sending to PACS, adjust this
setting.

1. Select the Masking tool from the pop-menu on the left-hand side of the screen.

- - ‘

There is the option to select one masking box, two masking boxes \ Y, three masking boxes - ~, or

polygon masking \.@.

2. Click and drag the Masking Box to the desired size.

Upon releasing the mouse button, the outer portion of the Masking Box is masked out.

esting - 195313717

To use the tool, the User simply clicks sequentially the corners of the polygon the User wishes to create.
Additionally, the User can change the placement of a corner by holding and dragging it. To finish the shape, the
User should click on the original starting point.
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To hide the Masking Box, click the Forbidden Mask button in the tool bar.

To remove a mask, click the Reset button.

Image Stitching

-~

e

P

See Section Image Stitching on page 53

ICE2 Processing
L 0 P A A e : o
The ICE2 Processing allows the User to apply different image enhancements to the image.

By default, every image receives Standard processing ‘- 0 . If the Standard processing is not adequate, the User
may reprocess the image to suit their needs.

The Soft process ‘- O ~will yield a more " film-like" image, i.e., finer tonal gradation with less sharpness, while the

Sharp process - A Jwill yield an image with more contrast and greater edge sharpness.

To use ICE2 Processing, first open the pop-up menu on the left-hand side of the screen. Then click the desired
processing button. Depending on the computer speed, the process may take a minute. The progress is shown in the
image thumbnail on the right-hand side of the screen (while the image is being processed, it will say *"processing" in
the lower, left-hand corner of the image thumbnail).

No Skin Line Detection Processing
- -~
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The No Skin Line Detection Processing allows the user process mammography images without skin line detection.
The tool is available only when a mammography image is displayed in the Image Display Window. To use No Skin
Line Detection Processing, first open the pop-up menu on the left-hand side of the screen. Then click the shaded
breast button. Depending on the computer speed, the process may take a minute. The progress is shown in the image
thumbnail on the right-hand side of the screen (while the image is being processed, it will say " 'processing" in the
lower, left-hand corner of the image thumbnail).

Horizontal Grid Line Removal
P = E

\;@uu |

If a grid has been used in the horizontal orientation, click Horizontal Grid Line Removal to run the grid line
removal processing.

Vertical Grid Line Removal

.'-'._

™

If a grid has been used in the vertical orientation, click Vertical Grid Line Removal to run the grid line removal
processing.

CR Markers
| m& I
h — A A
CR Markers allow the User to place an L or R marker on the image to indicate the laterality. To use a CR Marker, first
open its pop-up menu from the left-hand side of the screen. Then click where the marker should be. There are three

different sizes of marker. The User may toggle through the size by clicking on the marker again. At any time, the User
may click, hold, and drag to reposition the marker.

Measurement

1 2 3|
11 IIIII

e A

The Measurement tool allows the User to draw a line with a linear measurement on the image. To use the
Measurement tool, first select it from the pop-up menu on the left-hand side of the screen. Then click, hold, and drag
out the measurement line to the desired length and position. Release the mouse button when the measurement line is
sufficient. The measurement will appear next to the line.

True Size Calibration Tool

e "
3 =
=
h e
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The True Size Calibration Tool allows the user to calibrate image measurements based on an object of known size in
the image.

To use the True Size Calibration Tool:

1. Place an object of known size at the level of the anatomy for calibration.
2. Expose the cassette and scan the image.

3. Select the True Size Calibration Tool from the tool from the pop-up menu.
4. Click, hold, and drag out the line over the object of known size.

The Calibration dialog box will appear.
5. Enter the size of the known object in the Calibration Value input field, then click Confirm button.

All measurements on the image will be calibrated to the true size.

Angle

e A

The Angle tool allows the User to draw an angle with the interior measurement on the image. To use the Angle tool,
first select it from the pop-up menu on the left-hand side of the screen. Then click, hold, and drag out the first leg

of the angle to the desired length and position. Release the mouse when the first leg is sufficient. Click the mouse
again at the point where the second leg of the angle should end. The second leg of the angle will be drawn and the
measurement displayed at the vertex. At any time, the User may click the end of either leg or the vertex and readjust
the position of the angle.

Cobb Angle

& T
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The Cobb Angle tool allows the User to draw a Cobb Angle with an angle measurement on the image. To use the
Cobb Angle tool, first select it from the pop-up menu on the left-hand side of the screen. Then click, hold, and drag
out the first line of the Cobb Angle to the desired length and position. Release the mouse button when the length and
position are sufficient. For the second line of the Cobb Angle, click, hold and drag out the line. Release the mouse
button when the length and position is sufficient. At any time, the User may click the end of either line and readjust
the position of the angle.

Center Point

The Center Point tool allows the User to define two points on the image, with a third point the center mark. To use the
Center Point tool, first select it from the pop-up menu on the left-hand side of the screen. Click once where the first
point should be and once where the second point should be. A third point will appear marking the center point on the
line. At any time, the User may select either end point and readjust the position.
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Heart to Lung Ratio

o h

The Heart to Lung Ratio tool allows the User to measure the heart to lung ratio on an image. To use the Heart to Lung
Ratio tool, first select it from the pop-up menu on the left-hand side of the screen. Then click, hold, and drag out the
first line of the Heart to Lung Ratio to the desired length and position. Release the mouse button when the length and
position are sufficient. For the second line of the Heart to Lung Ratio, click, hold and drag out the line. Release the
mouse button when the length and position is sufficient. At any time, the User may click the end of either line and
readjust the position.

Units of Measurement

The Units of Measurement allow the User to toggle the displayed unit of measurement between inches, millimeters,
and pixels. To change the unit of measurement, open the pop-up menu on the left-hand side of the screen. Then click
the desired unit of measurement. The unit of measurement will change to reflect the selection.

Erase Annotations

i "

L -~

The Erase Annotation tool allows the User to erase a single annotation at a time. To erase an annotation, first select it,
then click Erase Selected button from the pop-up menu on the left-hand side of the screen.

Erase All Annotations

~ o

The Erase All Annotations tool allows the User to erase all annotations made on an image. To erase all annotations,
click Erase Selected button from the pop-up menu on the left-hand side of the screen.

Arrow

F o “y

o, -

The Arrow tool allows the User to draw an arrow on the image. To use the Arrow tool, first select it from the pop-up
menu on the left-hand side of the screen. Then click, hold, and drag out the arrow to the desired length and position.
Release the mouse button when the arrow is sufficient.
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Text Annotation

The Text Annotation tool allows the User to write text on an image. To use the Text Annotation tool, first select it
from the pop-up menu on the left-hand side of the screen. Then click in the where the text should appear on the image
and enter the desired text. Press the Enter key to finalize the entered text.

Pre-defined Text Annotation

The Pre-defined Text Annotation tool allows the User to apply pre-set text to the image. To use the Pre-defined Text
Annotation tool, select it from the pop-up menu on the left-hand side of the screen, then select the desired pre-defined
text. Click in the desired location on the image, and the pre-defined text will be applied.

Line

r ™y

]
&

The Line tool allows the User to draw a line on the image. To use the Line tool, first select it from the pop-up menu
on the left-hand side of the screen. Then click, hold, and drag out the line to the desired length and position. Release
the mouse button when the line is sufficient.

Extended Line

=
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The Extended Line tool allows the User to draw a line on the image that extends all the way through the image. To
use the Extended Line tool, first select it from the pop-up menu on the left-hand side of the screen. Then click, hold,
and drag out the line to the desired position. Release the mouse button when the line is sufficient. A line will be drawn
all the way through the image.

Hide/Show Annotations

#~ Ty

L -

The Hide/Show Annotations tool allows the User to show or hide the annotations for the current image. To use the

Hide/Show Annotations tool, first open the pop-up menu on the left-hand side of the screen. Then click the Hide/
Show Annotations button to hide or show the annotations on the current image.

Note:
|
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If annotations are hidden, no new annotations can be made on the image. To make a new annotation, make
sure the annotations are not hidden.

Information Overlay

i ™

L o

The Overlay tool allows the User to show/hide the patient information associated with the image currently being
viewed. To use the Overlay tool, first open the pop-up menu on the left-hand side of the screen. Then click the
Overlay button until the desired amount of patient information is displayed on screen.

Reset Image

The Reset Image tool allows the User to remove any Window/Level, magnification, and rotation from the image. To
use the Reset Image Tool, left mouse click the button in the pop-up menu on the left-hand side of the screen.

Processing Parameters

The Processing Parameters are various selected settings used for image processing.

To view the processing parameters of a specific image, double click on the white, study description text located to the
right of the image tools.

This will display the processing parameters, which will appear on the right side of the screen.
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To modify the Processing Parameters, see Section Processing Parameter Evaluation on page 90.

Multi-Tile Mode for Side by Side Image Acquisition and Comparison

XC employs a feature called multi-tile display which allows the user to perform side by side image acquisition and
comparison. The multi-tile display is available in the Image Display Window.

+ To activate a 2 x 1 multi-tile display, drag one of the gray buttons located on the edge of the image thumbnail
gallery to the center of the screen.

Similarly, to activate a 2x2 multi-tile display, drag both buttons to the center of the Image Display Window.

» To resize the multi tile window, click on the horizontal line or vertical line seen on the Image Display Window and
drag to the desired position.

» To perform image acquisition, select one of the multi-tile window and the window border will turn green. Click
the Add View button to perform image acquisition for the selected window.

© 2003-2014 Page 51 of 100 Doc # HC-XC-0028-05 Rev E-02

Confidential and Proprietary February 26, 2014
Property of iCRco, Inc.



| Tools and Processing | 52

» To display an image, select one of the multi-tile window and the window border will turn green. Then,
click on the desired image from the image thumbnail gallery to load the image onto the window.

E - 223 Brocessing Complete e
Ches! andseape, Right st AR

-

Note:

If XC is connected to two scanners, the user can select another multi-tile window and succesionally perform
side by side image acquisition.

Multi-Touch Gestures

For touch screen interface users, XC employs multi-touch gestures to ease the user in navigating through the software
and perform actions.

The available multi-touch gestures for XC include: One Finger Tap Two Finger Swipe Two Finger Rotate Two Finger
Pinch and Stretch Three Finger Drag

Note:
[}

The user must have a touch screen with multi-touch gesture support in order to utilize this feature.

One Finger Tap

A one finger tap is used to select an object similar to how the user uses the mouse to click on an object.

One Finger Scroll

A one finger scroll is used to scroll through the patient's list or study list in the Patient List Window or Study List
Window.

A scroll is a vertical movement.

Two Finger Swipe
A two finger swipe is used in the Image Display Window to navigate previous or next image in a series.

A swipe is a horizontal movement.

Two Finger Rotate

A two finger rotate is used in the Image Display Window to rotate an image clockwise or anti clockwise.

Two Finger Pinch and Stretch

A two finger pinch and stretch is used in the Image Display Window to zoom in or out on an image.
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Three Finger Drag

A three finger drag is used in the Image Display Window to pan an image.

Image Stitching

The stitching operation allows you to stitch two images together vertically. You can stitch together more images by
repeating the process.

Note:

Before stitching, acquire the two images to be stitched together. One of the acquired images will be the top
portion of the stitched image and the other will be the bottom portion.

1. Open the Study in XC.

2. Load the two images in the viewing window by dragging and dropping them in the window. Place the images in
the appropriate display region.

Note:

You can adjust the grid positions by dragging the grip handle tabs found at the right edge and bottom of
the screen.

-

3. Click on the “Crop and Mask” icon (3rd from top) from the main menu, and then click the stitch icon. The
stitching tool dialog box will appear.

Note:
If the dialog box does not appear, you will need to go back to Step 1 and load the images in the correct
positions.
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5. If the images are not aligned properly, use the Stitching Tool Coordinate System to adjust the stitching location.

Note:

|
To adjust the stitching location, use the four directional buttons (Down, Up, Left, Rigth) to shift the image.

Alternatively, adjusting the sliders or entering coordinates in the text fields will move the image.
When the image has been shifted to the desired location, click Stitch to redo the image stitching.
Note:
It is possible to move the Stitching Tool Coordinate System window.
Note:

|

Do Not click Done until you are satisfied with the stitching location.

6. Click Done to finalize the image stitching.

Exposure Index

Since light or dark images (optical density) are no longer a factor with CR, users are often unsure of exactly what
exposure factors to use. The calibration of a good exposure index can clear that confusion by indicating when optimal
energy (exposure) is acquired by the IP (Imaging Phosphorus Plate). The iCRco Exposure Index is a user friendly
guide to help users develop a working technique chart that is specific to the output of the x-ray machine.
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How It Works

The iCRco Exposure Index is a pre-determined, factory calibrated energy level “sweet spot” that is a compromise
between signal (exposure factors) and noise (image grain); in other words, the greater the signal the lesser the noise
and vice versa. Hence, observing the exposure index allows the user to work to an ALARA (as low as reasonably
achievable) exposure requirement while keeping image noise to a tolerable level.

CR EXPOSURE

Effect of Exposure on Image Quality

IMAGE QUALITY 3.8

HicH NoISE OPTIMUM VERY GooD

-
o

o
o

'
-
o

&
o
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PHOSPHOR STORAGE PLATE (IP) EXPOSURE

Reading the Exposure Index

The exposure index is documented in the Patient Information Overlay as a positive or negative number that is red if it
is over the value of 1.0 (positive or negative), and green if it is within 0.0 to 0.9 (positive or negative).

EXPOSURE INDEX

Reading The Exposure Index

0.0
-1.0 “Step” Under +1.0 “Step” Over
Exposed Exposed

Optimum

Adjusting Exposures Based On the Exposure Index Data

Users should consider the exposure index value equivalent to steps in conventional film density or a percentage

of exposure technique values. For example; a value of 1.5 is equal to +1.5 steps in conventional film density or
150% more than the ALARA optimal exposure energy for CR. Conversely, a value of -1.5 is equal to -1.5 steps in
conventional film density or 150% less than optimal exposure energy for CR. Exposure Index values of 0 to +/- 0.9
are within the target range for energy (exposure) to the IP.
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Note:

As indicated above, the ALARA requirement does allow for some image noise to maintain minimal exposure
values; therefore, users will note decreased noise levels in the positive ranges of the exposure index (0.3 to
0.9) while avoiding the pit falls of “Dose Creep” that is often associated with CR and DR. Conversely, users
will note increasing levels of image noise in the lower (negative) ranges of the Exposure Index values (-0.3 to
-9).

A Word on Exposure Math

The values of mAs, mA and exposure time are exponential, for example; to increase or decrease the exposure energy
by an Exposure Index factor of 1 (100%), double or half the mAs, mA or exposure time.

EXPOSURE MATH

The values of mA, mAs, and exposure time (Sec) are
exponential.

To increase or decrease the exposure energy by a factor
of 1 “step”, double or half the mAs, mA, or exposure time.

The values of kVp follow the 15% rule. In other words, to double or half the exposure energy with kVp, add or
subtract 15% of the total kVp. For example; to increase or decrease the exposure energy by an Exposure Index factor
of 1 (100%), add or subtract 15% of the kVp: 100kVp -15% = 85kVp, 60kVp +15% = 69k Vp.

EXPOSURE MATH

The value of kVp follows the 15% rule.

To increase or decrease the exposure energy by a factor of
1 “step” (100%), add or subtract 15% of the kV/p

Example: 100kVp +/- 15% = 115kVp/85kVp
70kVp +/- 15% = 80kVp/60KVp

Deviation Index

The Deviation Index is used specifically for mammography. To follow ACR guidelines, MQSA guidelines, and
ALARA, optimal image quality and limited exposure is required for all mammography images.

The Deviation Index provides a reference to the user on the acceptability of the imaging plate dose in relation to the
type of exposure. Like the Exposure Index, the Deviation Index can help a user develop a technique chart for the
user’s X-ray machine.

How It Works

The Deviation Index is a predetermined, factory-calibrated, energy-level “sweet spot” based on the exposure of an
ACR MAPP phantom that results in optimal image quality that passes testing at the lowest possible dose.
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Reading the Deviation Index

The Readout of the Deviation Index serves as an image quality metric; generally, a positive value indicates over-
exposure, while a negative value indicates under-exposure.

Note:

If exposing a breast that is larger or smaller than a 4.0-4.2 cm breast, positive and negative values may not
correspond to over-exposure and under-exposure, respectively.

A site is required to develop its own technique chart upon installation of the system so that a user can reference the
expected DI value for various dose readings.

Below is an example of a Technique Chart.
Note:

The example chart and data should not be used for clinical interpretation.

Table 1: Example Technique Chart

Breast Composition Target Filter kVp Density Optimal DI
Thickness Readout
<3cm 50/50 Mo Mo 26 -2 -1
3-5cm 50/50 Mo Mo 28 -1 0

5-7 cm 50/50 Mo Rh 29 0 2

>7 cm 50/50 Mo Rh 30 1 3

The installation site can determine how precise the thickness, composition, and exposure settings should be in the
Technique Chart.

The user should check the Optimal DI Readout for all clinical exposures.

A Dl is considered acceptable if it is within one step of the Optimal DI Readout. For example, if XC outputs a DI
value of 4 for a 5-7 cm breast at 29 kVp and the Optimal DI Readout value is 2, then the plate was over-exposed since
the DI value is two steps away from the Optimal DI Readout value.

Adjusting Exposure Based On the Deviation Index Data
Deviation Index = 10 * log;g(Measured Dose / Expected Dose)

Each +1 increment of the Deviation Index indicates a 25 percent increase in dose, while each -1 increment indicates a
20 percent decrease in dose.

For Example:

Let's say the Expected Dose is 20 mR. An exposure gives us a plate dose of 40 mR and a DI readout of 3.
If a DI of 4 is needed:

1. Increase the exposure by 25 percent (40 * 0.25 + 40 = 50 mR total)

If a DI of 2 is needed:

1. Decrease the exposure by 20 percent (40 - 40 * 0.2 =32 mR total)

If a DI of 0 is needed, the calculations will need to be performed one step at a time:

1. Decrease the exposure by 20 percent (40 - 40 * 0.2 =32 mR) (DI of 2)
2. Decrease the Step 1 exposure by 20 percent (32 - 32 * 0.2 =25.6 mR) (DI of 1)
3. Decrease the Step 2 exposure by 20 percent (25.6 - 25.6 * 0.2 = 20.48 mR) (DI of 0)
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A Word on Exposure Math
It’s possible to adjust the level of exposure delivered to the plate by modifying the kVp, mAs, or exposure time.
Increasing the mAs by 25 percent will also increase the exposure level by 25 percent.

Increasing the kVp by 15 percent will increase the exposure level by 100 percent (this is known as the 15 Percent
Rule). Increasing the kVp by 3.75 percent will increase the exposure level by 25 percent and decreasing the kVp by 3
percent will decrease the exposure level by 20 percent.

Advanced DICOM Printer

Selecting Studies for Printing

1. In order to launch Print Tool. Select a patient from the worklist.

2. On the Studies screen, click Send Study > Print Study > Send Images to Print Tool button. The Print tool will
be launched.

Alternatively, it is possible to print using a paper printer by selecting the Paper Print button in the Print Study tab.

Drag and Drop Images

To drag images into the print region hold the left mouse button down on one of the image icons on the right hand side

and drag it into the preview window. A dragging cursor will appear bf—]as the user drags the image from the image

icon window to the preview window. If the user is out of the accepted region for dropping, a cursor O will appear
letting the user know that this is not a correct region to drop the image into.

Previes Tmages

Page Loof L

Split the Preview Window into Regions

To split the preview window the user needs to first select the region to split. For example, if there are currently no
divisions in the preview window then click anywhere in the preview window and a green line will appear around
the window. This will enable the image division buttons. Alternatively, the user can press Shift+ . .right mouse click
inside the preview window region to split it. A pop-up menu will appear with these division buttons (as the image to
the right shows).
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Select one of the image division buttons and the preview window will be divided into regions. To split one of these
regions again select the specified region and again select one of the image division buttons. The user can drag and
drop images at any stage. If the user has an image in the region that is desired, the interface will automatically move
the image into the split regions. To remove a division, click in the region that has been split and click on the no-

division Ebutton.

Templates | Lego

Label

Page Layout

Printers

Fop—

The user can show and hide the image divisions by clicking on the Page Layout tab, then click Show and Lock
under Image Divisions. The user can view the current print settings by looking at the left hand side of the Advanced
DICOM Printer dialog. To change these settings, or to view more settings, click on the Printers tab.

Test Printer
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Manipulating Image in the Preview Window

Overlay | Templates | Logo Label
Image Page Layout Printers

Selected Image
Width| 'BEE | Window 7552

Height 1496 Level 48565
Zoom 164%  Update

Max. Zoom Level  200% W

ITIP|9
AR BN
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The Advanced DICOM Printer allows the user to flip, rotate, zoom, pan, invert and window/level images. To
manipulate the images select the image in the preview window (the selection will be shown by the green box

surrounding the image).

The user can flip, rotate and invert by using the buttons on the left hand side of the DICOM Printer dialog.

The user can zoom by using the right mouse button on the selected image.

To pan the image use the left mouse button on the selected image.

Note:

The User can only pan the image when it is zoomed in.

To window/level the user can either use the middle scroll button on the mouse or type the required window/level
into the edit boxes on the left hand side of the Advanced DICOM Printer dialog. Then press the Update button to

change the window/level for the image.

The user can also press the 1:1 button to print images at 1:1 resolution.

The user can use the Orientation button to change from landscape to portrait view.

Changing Margins

The margin tab permits the user to specify, in English or metric units, the size of the borders on the printed image. The
top and bottom borders on the page can be adjusted independently of the borders for the left and the right hand side of

the page.

Overlay | Templates | Logo Label
Image Page Layout Printers
Page Properties

Qi ion:  Image Divisions:

Show

[ Landscape [iod:

(®) Inches mm
Borders

LeftRight  0.05
Top,/Bottom 0.05
Image Spacing
() No Space Between Images
(®)Same as Border Spacing

| Double Border Spacing
() Custom Spadng
0.00
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Additionally, the user has the option to control the internal margins, which define the amount of space left between
individual frames on a page with multiple images. Internal margins are defined as multiples of the print page border
size.

By default, internal margins are the same size as the borders, with image margins on, the left and right hand side of
each frame are equal to the left and right hand borders. Margins on the top and bottom of each frame are equal to the
top and bottom borders of the printed page.

If the user intends to cut individual frames out of the printed page, it is recommended that internal margins are set to
twice that of the page, which will give a uniform border size on the individual image segments. If it is necessary to
maximize the amount of space on the printed page, the internal margins can be turned off altogether.

Saving and Loading Print Layouts

The Templates tab allows the user to save and load pre-defined print layouts. There are five user defined layouts. Set
up the layout on the preview window and then select one of the buttons labeled Click here to save current layout!
The user will be prompted for a title.

To save more layouts click on the Save Current Template button. Here the user can set a file name for the Layout.

Image Page Layout Printers
Overlay | Templates | Logo | Label

Click here to save current
layout!

Click here to save current
layout!

Click here to save current
layout!

Click here to save current
layout!

S P (<] Click here to save current
t il PR el layout!

Template Manager

Load Template from File

Save Current Template

If only a single procedure was loaded (all of the images are from the same procedure) and a layout was applied to the
print of the procedure, then the layout will be saved when the user prints the image.

The next time the user loads this procedure, Print Tool will apply the saved layout.
Note:

Images will be positioned based on anatomy and laterality.

Adding Patient Demographics
Select the Overlay tab to bring up the patient demographic layout options.
From here, the User can select:

» Text position (includes top left, top center, top right, bottom left, bottom center, bottom right),
» Text size (includes: small, medium, large),
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» Text color (includes: white on black, black on white).

Patient Demographics Overlay g[

T et Position

Image Page Layout Printers
Overlay | Templates | Logo | Label

Text Position

An-pl_l.'l-ualm:g::‘ Apply 1o mags

o NN P
o PR
H B NE
() Small (®)Large
(I Mediurn [ ¥Harge
Ted Sie Tt Cooko
Cond O || TetC
o white on Black
4 r::ﬁ.m . T — A hite on Black
e (®) Black on wWhite
W Enabls Dvw
"‘W:f::: i /| Enable Overlay
B aeplyto i
; Edit Fields
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he user has the option to apply the current settings to every image in the print view or only in the currently selected

image via the Apply to all images button or the Apply to image button.

By selecting the Enable Overlay check box the user can turn patient demographics overlay on and off for all images.
The user can also edit the fields that are available on patient demographics overlay by clicking on the Edit Fields

button.

From here, the User can:

» Select a field and determine what kind of a delimiter following the field (includes: none, space, tab, comma,
newline, custom).

» Change the position of the fields with the up and down arrows.
» Remove or display a field by selecting the Print Field check.

» Print the title for the field (i.e. the title "Date:" would be printed in front of the date field).

After editing the fields, click the Done button.

Print Preview

To see a print preview, click the Print Preview button.
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Printing Images to a DICOM Printer

When the user has finished dragging and dropping the desired images onto the preview window and manipulating
size, position and window/level (if necessary), then press the Print button in the bottom left hand corner of the
DICOM Printer dialog. Please ensure all the printer settings are correct first.

Patient Demographics for Icons

When the cursor is over the icon bank, Advanced DICOM Print will display the demographics for the image.

test test 10006 1/1/2013 test a test 9
18/2013 10:32:13 AM Abdomen - 2 views
ABDOMEN AP F 9/19/2013 10:32:13 AM
AP

Multiple Icon Pages

Advanced DICOM Print has an unlimited number of icons that can be loaded. However, the PC's memory is a
restriction.

To clear the current page of icons, click on Clear Current Page button. To clear all the pages of icons and preview
window, click on Clear All Pages button.

To move between pages and move to first and last pages click on the arrow buttons.
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Clear Current Page
Clear All Pages

Configuring a Printer with the QPC Print Tool

The following section demonstrates how to setup a DICOM film printer with the QPC Print Tool.

1. Open the QPC Print Tool.
2. On the Printers tab, select the Settings button.
The DICOM Print Settings window will appear.

3. Select the printer make and model from the Printer drop-down menu. If the make and model of your printer is not
available, select Standard Printer.

4. Select the "..." next to AET.
The Image Targets window will appear.
5. In the Image Targets window, select Add New.
6. Enter the target system's AET, IP address, and port number. Ensure the compression is set to "none" and the Target
Type is "DICOM".
Click OK.
7. In the Image Targets window, select the target you just created, then select the OK button.
In the DICOM Print Settings window, select the OK button.

8. In the Advanced DICOM Printer window, select the Printer 1 button (or the applicable printer), then select the
Test Printer button to test the association to the printer.
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Status and Icon Indicators

XC has many status icons and status indicators. The following section describes those indicators.

Hard Disk Indicator
| Disk Used [ 5% |

The hard disk indicator shows the user how much disk space has been used. It can be located on the Worklist screen.

Wireless Indicator

|.\ Wireless Signal _ml"ﬂr

The wireless indicator allows the user to see the strength of the computer's wireless connection. It is positioned on the
top right corner of XC's window when the computer is on wireless connection.

Note:
[ |

The wireless indicator is not displayed in the Image Display window.

Battery Indicator

: Battery Level ﬁﬁ :
— 7 )

b

The battery indicator currently only shows with the Vmotion hardware is in use. The battery indicator allows the user
to see the strength of the computer's battery. It is positioned on the top right corner of XC's window, to the right of the
wireless indicator when the computer is powered by battery. When the battery is critically low, the computer will be
shutdown.

Note: The battery indicator is not displayed in the Image Display window.

Patient Status Icons

The Patient Status icons quickly tell the user what phase the patient study is in. The Status icon can be one of
1. Scheduled

2. Stat

3. In Progress

4. Finished
™

The user may cycle through the available status by clicking the Status button in the Studies window.
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License and Version Information

The user can find the XC version number and licensing information by clicking iCRco.

The About window will pop-up.

Default font provided by SIL (httpa/f
www.SILorg).

: Non-DICOM image handling

This is version: 0.1.0.31 courtesy of Freelmage via the FIPL
(httpe/{freeimage sourceforge.net),
Local DICOM handling courtesy of
GDCM via the BSD license (httpe//
sourceforge.net/projects/gdom).
DICOM networking handied by
demtk (hitp//dscom.offis.de).

Enabled Feature
Annotations
Write Study CD
Print
Dicom Send
Worklist Query
ICE
Medical
Mammography
Podiatry

Software license is set to expire:
6/26/2013
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Managing Patient Data

Creating Patients

1. From the Patient List window, click the Schedule Patient button.
2. Fill in the desired patient information.

L Note:
' Required fields are marked with an asterisk (*). Last Name, First Name, Referring Physician, Patient ID,
date of birth, and Institution are required fields.
Note:
0

Fields with green titles can be used as Modality Worklist Query fields. For more information on Modality
Worklist Query, see Section Setting Up Modality Worklist Query on page 88

3. Click the Finish button to return to the Patient List window, or click the Finish And Scan button to begin the
process of scanning an image.

— FPatient Info. ~ — Study Info

__-.Q@Q@QQ@I@@__

T .
“_QQGQQMQQWWL__

Figure 2: XC's Patient Data Entry Screen
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1. Locate the desired patient in the Patient List window.

2. Click the desired patient's Patient Information Bar.

il =

3. In the Study Information window, click the Patient Information Bar again.

4. Edit the desired information.

o Pt Coe—r

[ —
=7 =

5. Click the Finish button to save the changes and return to the Study Information window.

Editing Study Information

1. Locate the desired patient in the Patient List window.
2. Click the desired patient's Patient Information Bar.
3. In the Study Information window, click the Study Information Bar.

'Stufﬁes E—

4. Edit the desired information.
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5. Click the Finish button to save the changes and return to the Study Information window.

Exporting Data

1. In the Patient Information window, click the desired patient.
2. In the Study Information window, locate the study to export.

Click the Send Study button. This will bring up the Export window.
3. From the Export window, the User may: Export to Disk, Write Study CD, Print Study, or DICOM Send.

Export to Disk

1. In the Export window, click the Export to Disk button.
2. Select the drive (USB drive, or other system partition) to export to in the Select Drive drop-down menu.
3. Select DICOM, JPEG, or TIFF as the export image format.

If necessary, select the Anonymize button.
4. Select the drive to export to.
5. Click the OK button to export the study.

Write Study CD

1. In the Export window, click the Write Study CD button.

In the Select Device drop-down menu, select the CD/DVD drive.
Load a CD/DVD into the drive.

Click the BURN button.

Depending on the number of flies being exported, the speed of the system, and the speed of the burning device,
this operation could take a few minutes. Please be patient while the CD/DVD burns.

Nk wN

Print Study

1. In the Export window, click the Print Study button.
2. The print application will open and load the images from the study to print.

Note:

See Section Advanced DICOM Printer on page 58for more information about the Advanced DICOM Print
application.

DICOM Send
1. In the Export window, click the DICOM Send tab.
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2. Select the check box next the desired AE Title(s).
3. Click the OK button to initiate the DICOM send.

Rejecting an Image

When an image is unsuitable for a diagnostic reading, the User should reject the image. The image may be rejected
for many reasons: patient movement, wrong image in patient folder, operator error, etc.

1. Acquire or open an image.
2. Click "Reject" button at the bottom left hand side.

3. Select the reason for the the rejection and click "Confirm".
The image will be removed from the study and added to the Image Rejection Report in XC and the QC Tool.

Removing Single Patients

Note:
A patient can only be removed if it contains ZERO studies.
Reject or move the images to remove them from the study.

1. From the Patient List, select the patient to be removed.
2. In the Study Screen, click the Patient Information bar to open the Edit Patients screen.
3. In the Edit Patient screen, click the Remove Empty Patient button.

A conformation dialog box will open. To remove the patient, click Yes. If successful, the User will be returned to
the Patient List window.

Removing All Patients

Important:
Once removed, patient data is not recoverable. Perform a back-up before removing any patient data.

1. Ensure that Hidden Files and Folders are viewable, as covered in Showing Hidden Files and Folders in Windows
on page 99.
2. Navigate to the 1CRco XCfolder.
*  On Windows XP, the path is C: \Documents and Settings\All Users\Application Data
\XC\.
*  On Windows 7, the path is C: \Program Data\XC\.
3. Inthe XC folder, delete the folders Patientsand Studies, and the content of both folders.

Querying a Worklist

XC can be configured to automatically query a DICOM Modality Worklist Server (See Section Setting Up Modality
Worklist Query on page 88 for more information on configuration). The worklist can then be queried by any green

field on the Patient Scheduling screen. The query can be based on any of the green fields or a combination of green
fields:

1. In the Worklist Query fields at the top of the Patient Information screen, enter the desired search criteria.

For example, to query by Patient Name, enter part or all of the patient's name into the LAST NAME search box.
To query by Accession Number, enter the Accession Number into the ACCESSION NUMBER search box.

To query by a combination of values, enter the desired search criteria into more than field.
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2. Click the Query Worklist button to initiate the query.

+ Ifthere are multiple matches, the results of the query will be displayed in the Worklist Query Results
dialog. Then select an entry from the results and click Use Selected. The information from the selected entry
populates the Schedule Patient date fields.

Note: In the Query Results dialog, the list can be sorted by clicking column headers and the columns
can be reorder by clicking and dragging. The new column order is saved.

» If there is only one result that entry is automatically used to populate data fields.

© 2003-2014
Confidential and Proprietary
Property of iCRco, Inc.

Page 71 of 100

Doc # HC-XC-0028-05 Rev E-02
February 26, 2014



| Managing Patient Data | 72

© 2003-2014 Page 72 of 100 Doc # HC-XC-0028-05 Rev E-02
Confidential and Proprietary February 26, 2014
Property of iCRco, Inc.



Chapter

6

Configuration

Configuration

The Configuration window contains all of XC's preference & User settings.

Only Users with Administrative privileges can access the Configuration > Admin tab.

:"'C'Emd"gurag.:m

Figure 3: XC's Configuration Screen

Configuration > DICOM

The DICOM tab holds all the DICOM target information, as well as configuration settings for DICOM Modality
Work List Query and DICOM Auto-Send.

DICOM Setup

The DICOM Setup tab contains a list of AET's known to XC. From the DICOM Setup tab the User may add,
remove, edit, and test AETSs using the appropriate button.

Work List Inputs

The Work List Query tab allows the User to easily set DICOM Modality Work List Query. Check the box next to the
desired AET, then choose the query interval.

Auto Send Targets

The Auto Send Targets tab allows the User to easily set DICOM Auto Send. Check the box next to the desired AET,
and when an image is accepted, it will be automatically send to the checked target(s).
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Pending

The Pending tab provides the User with a list of files that have been scheduled to DICOM Send, but have not actually
been sent yet. This is only a list of files, the User may not interact with anything on this tab.

Click Clear to remove all items from the Pending DICOM Sends list.

To DICOM Send, ensure the computer has the proper network connection and the Auto Send Targets tab has been
correctly configured.

Configuration > Device Settings
The Device Settings tab holds the settings for the scanner hardware and X-ray generator (optional).

Device Settings

The Device Settings tab allows the User to know the serial number and scanner model attached to the computer
system, the specification of the spot size for normal and high resolution scans, enable demo scans, deep erase IP
Plates, and provides access to the hardware EEPROM dialog.

For This Device
This drop-down menu allows the User to select the scanner model.

If you have multiple scanners, or multiple capture devices (such as the Fusion DCR or Fusion DCR Flat Panel) there
will be multiple selections in the drop down menu. Each device in the drop-down menu can have it's own Alias, Plate
Size, and Spot Size Settings.

Alias

For each device, the User may assign it an alias, or another name to call the device. This name will show up as the
device name in the Scan tab. This feature is useful if more than one scanning device or a multiple capture device
(such as the Fusion DCR or Fusion DCR Flat Panel) is plugged into the computer.

For example, if the User has one Fusion DCR Flat Panel and one iDR Long Bone plugged into the same computer,
the user could "alias" the Fusion CR as "CR Scanner," the Fusion DR Flat Panel as "DR Scanner," and the iDR Long
Bone as "DR Long Bone." Each would show the "alias" name on it's respective tab on the Scan screen.

Scan Preview

If checked, XC will display portions of the image as the plate is scanned. If unchecked, the program will wait until the
scan is finished before displaying the entire image.

Plate Size and Spot Size
Each plate size can hold it's own spot size settings for both normal and high resolution scans.
To set a plate and spot size:

1. Select the desired plate size from the Plates sized drop-down menu.
2. Select the desired spot size for both normal and high resolution using the Spot Size drop-down menus.
3. Click the Close and Accept button to save the changes.

CR Settings
Only certified technicians should alter the CR Settings. Entering improper values may damage the hardware.
The CR Settings allows the User to view the Exposure Index information (System Speed, Alpha, and Mu values).

The Advanced button reads in the settings from the scanner's EEPROM, and allows the User to edit these values.
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Demo Settings

Turning on the Enable Demo CR option will allow the User to mock-scan an image without a scanner attached to the
computer. An image from the demo images library will appear when scanned.

Turning on the With CR Motor option will also the user to cassetteless scan in demo mode a with a scanner attached.
The scanner will then run the motor, but will not acquire an image from the plate; instead it will use an image from
the Demo images library.

X-ray Tubes

Allows the User to choose which generator interface and COM port to use. The Exposure Count section lists the
number of exposures taken with the generator interface. Click the Reset button to set the exposure count back to zero.

Exposure Count
The Exposure Count lists the number of exposures trigged via the generator interface.

Click Reset to change the exposure count to zero.

Configuration > Settings
The Settings tab contains general application settings, such as language and units of measurement.

Data Representation
The bit-depth of the DICOM file when it is DICOM sent or exported out of . Current options are: 16, 12, 10, or 8 bit.

Look Up Table Type

The type of Look Up table that is embedded in the DICOM file when it is DICOM sent or exported out of . Current
options are: Linear or Sigmoid. If Sigmoid is selected the DICOM Value-of-Interested Look-Up-Table (VOI LUT)
entries are generated and stored in the DICOM header.

Data Conversion Clipping Level

The level of noise removed from the data when the 16-bit data is scaled to a lower bit resolution (using the Data
Representation drop-down menu). A lower number means more noise will be included when the data is scaled.
A higher number means that some useful information will be clipped when the data is scaled. Only a certified
Applications Specialist should adjust this parameter.

Language
Sets the language of the User interface. Current supported languages are:

* English (US)

* Spanish

* German

* Chinese (Traditional)
* Chinese (Simplified)
+ [talian

» Portuguese (Brazil)

*  French
* Polish
* Croatian

* Romanian
e Czech
e Ukrainian
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Displayed Name Component

For Japanese language users only. The Displayed Name Component allows the user to choose between several
different Japanese character representations.

Character Set

Allows the user to choose which character encoding is embedded in the DICOM header. ISO_IR 192 is UTF-8. This
should be sufficient for the majority of systems.

Default Unit System

Sets the units of measurement for the measurement tools. Supported units of measurement are: Imperial and Metric.

Graphics-Acceleration

Controls whether the graphics rendering is done by the software or the video card. If the User notices problems with
the display of the graphics, this option should be disabled.

On Screen Keyboard

Toggles XC's built-in, on-screen keyboard.

Automatically generate IDs

Allows for the automatic generation of Patient and Study IDs. This feature if useful if you are not using a RIS/HIS/
EMR

Show Task-bar

Shows the Windows task bar when set to 'on.' Hides the Windows task bar when set to 'off.'

Auto Sort Patients

Automatically sorts patients within the selected date range. Available date ranges are: Within One Year, Within One
Month, Within One Week, Yesterday and Today, or Today.

iDR-L Full Erase
Allows the User to choose whether to erase the whole iDR-L plate after every scan. If set to ON, the whole IP plate,
regardless of region selected, will be erased. If set to OFF, only the scanned region will be erased.

Show Default Smart Box

Toggles whether the Smart W/L tool should be automatically applied after scanning an image.

Configuration > Admin

The Admin tab is only available to Administrative users and contains user accounts and data management options.

Imaging Domain

Sets the scan interface for Medical (general radiography), Mammography, Podiatry, Specials, Veterinary (small
animal), or Equine.

Note:
|
Available Imaging Domains are enabled/disabled on the USB Security Dongle Key.
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Launch Application Interface

The Applications Interface allows the User to change image processing libraries, define custom anatomy
projections, define and edit default processing parameters, automatically rotate and flip images, assign laterality,
adjust auto Window and Level values, enter exposure factors (for supported generator models), and restore defaults.

For more information on the Applications Interface, see Section Adding Categories and Views on page 89 and
Section Processing Parameter Evaluation on page 90.

Image Rejection Report

XC generates a report which contains all the information about the rejected images such as Patient ID, Anatomy,
View, Date/Time when the image was acquired, Date/Time when the image was rejected, Reason for the image
rejection, and Username. The user can save this report as a PDF. The following steps explain the procedure to
generate an image rejection report:

1. Click "Configuration" and select the "Admin" tab.
2. Click "Image Rejections" button.

3. The user can search a particular rejection report by selecting the options available in "Sort by", "From Date", "To
Date", "Reason", "User" and "Anatomy".

4. The user can choose a particular font style for the report by selecting "Font".
5. To save the report as a PDF, click on "Save to PDF" and save the file at the desired destination.

Apply Fine Removal Drop Down Menu

This menu allows the user to select the number of times the fine line removal needs to be applied to the image.

Data Location

The data location is the folder on the file system where XC will store settings and patient data. The default is the
location on Windows 7 is C: \ProgramData\XC.

There should not be a need to alter this location unless the hard disk is running out of space and the user does not have
archival storage (PACS).

24 Hours Study Management

The 24 Hours Study Limit option disables the ability for the user to add more images to a study that was created
twenty-four hours prior to the image addition. When it is turned on, the user will not be able to add more images to a
study that is 24 hours old or more.

Only an administrative user is able to change the setting of 24 Hours Study Limit.

Embedded Computer

The Is Embedded option allows for the scan software to control the computer restart and shut down commands. This
option is enabled if the scan software is installed onto a computer embedded with the scan unit. When this option is
on, the upper right power button in the software allows the user to restart or shut down the computer.

File Reader

The File Reader option allows for the scan software to import image files into the program. When the option is
enabled and the user clicks scan, the software will ask for the location of the image to be imported and the user can
select from multiple image rules (DICOM) .

Note:
|
This option should only be enabled and utilized by qualified personnel.
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Imported File Processing

The Processing option determines if images will undergo post-processing when imported. When the option is enabled,
the scan software will process imported images.

Note:

This option should only be enabled and utilized by qualified personnel.

Users

The Users tab allows an administrative User the right to add/manage User names and passwords for accessing the XC
application.

The Require Login toggles the User Login box functionality. If users must authenticate before using XC, turn this
feature on. If user accounts are not desirable, turn this feature off.

Adding a User Account

1. Open XC.
2. Login with the Administrator User name and password.
3. Click the Configuration button in the Patient Information window.

If prompted, enter the appropriate password to access the configuration settings.
4. Click on the Admin > Users tab.
Click on the Add button. The Add User dialog will pop-up.

6. Enter the desired User name and password (the password will need to be entered twice, once in the Password text
field, and again in the Confirm Password (text field), then click the Finish button.

7. If the new User account is to have administrative privileges, select the button Allow Access To Configuration
Settings.

8. The new User account will be created.

ol

Changing a User's Password

Open XC.

Login with the Administrator User name and password.

Click the Configuration button on the Patient Information window.

Enter the appropriate password to access the configuration settings.

Click on the Users tab.

Select the User account to modify by selecting the desired User account from the list.
Click the Edit User button.

IR A o .

The Edit User dialog will pop-up.

8. Enter the new password in the Password text field, then enter the new password again in the Confirm Password
text field, & click the Finish button.

9. The User's password will be changed.

Removing a User Account

Open XC.

Login with the appropriate User name and password.

Click the Configuration button on the Patient Information window.

Enter the appropriate password to access the configuration settings.

Click on the Admin > Users tab.

Select the User account to remove by selecting the desired User account from the list.
Click the Remove button. The Remove User dialog will pop-up.

Confirm the removal of the User account by clicking Yes in the Remove User dialog.

AU S e
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9. The User account will be removed.

Procedure

Procedures allow you to create a pre-defined set of image views. The procedure can then be selected on the study
portion of the Scheduling screen.

To create a procedure, see Creating a Procedure on page 88.

Data Management

The Data Management tab allows an administrative user to configure XC's disk usage. The goal of the Data
Management tool is to help XC minimize disk usage by removing old images. The features available for the user to
configure include setting a threshold value for overall use of disk capacity, an option to remove sent images after a
specified image age, deletion of rejected images, an option to enable auto purge and emptying a virtual trash bin.

Purge Constraints

The Purge Constraint feature allows the user to set the threshold value of XC's disk usage relative to the computer's
total disk's capacity for saving data. Higher threshold value means the user allows XC to keep more studies in the
hard disk , and inversely true, XC will keep less studies if the user sets the threshold value to a lower value.

To set the disk usage's threshold value, slide the Disk Usage Percentage slider to the desired value.

By turning on the Only Remove Sent Image option, XC will only remove a sent image from the study after a study
has reached a specified age and the threshold value is met. When the setting is turned off, XC will delete all images
contained in a study regardless of their status after a study has reached a specified age.

The Minimum Image Age (Days) slider allows the user to set the minimum age of a study. Any study older than the
minimum age will be removed from the folder once XC's disk usage has reached the set threshold value.

To set the minimum image age value, slide the Minimum Image Age slider to the desired value.
Note:

The Purge Constraints can be modified if the user is in need of more disk space, however this will delete
studies based on the constraint criteria. iCRco recommends that the user backup all studies on a regular basis.

Purge

Enabling the auto purge option will automatically trigger XC to move studies that have met the purge constraints to
the virtual trash bin.

The user can also move studies to the virtual trash bin manually by clicking the Purge Now button. All studies that
have met the purge constraints will be moved to the virtual trash bin.

Note:

If Auto Purge is enabled, it is not necessary to use the Purge Now button. XC will automatically purge images
based on the Purge Constraints.

Virtual Trash Bin

When data is automatically or manually purged by XC, it will be moved to the virtual trash bin. The virtual trash
bin indicates the size of data that will be permanently deleted from the computer and allows the user to permanently
empty the trash bin by clicking the "Empty" button.

Delete Images When Rejected

Turning on the Delete Images When Rejected option enables XC to automatically moves rejected images to the
virtual trash bin.
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Chrome Workflow Modes

In addition to the standard Manual Scan workflow modes, the Chrome and Chrome Duo can operate with XC using
an Auto Scan Mode and Barcode Mode. Each mode offers a different workflow. The user should choose the mode
that best matches their preferred workflow.

Note:

Modes can be activated in Configuration.

Manual Scan Mode
The user can begin a scan by selecting the bay holding the cassette.
Note:

When in Manual Scan Mod, XC considers the two bays of the Chrome Duo as two separate units connected to
a single computer.

To activate Manual Scan Mode:

1. Click the Configuration button on the Patient Worklist screen.

2. Select the Admin tab.

3. Select the Settings tab.

4. In the lower right settings filed labeled Chrome Settings, set the Barcode and Auto Scan buttons to Off.

Chrome Duo Settings
| Barcode Auto Scan
. ..

For information on the Manual Scan Workflow, see Section Manual Imaging Workflow on page 23.

Auto Scan Mode

When in Auto Scan Mode, XC allows you to start a scan without needing to select a specific bay or cassette size. The
user can simply insert a cassette into the bay and the scan will begin automatically.

To activate Auto Scan Mode:

1. Click the Configuration button on the Patient Worklist screen.

2. Select the Admin tab.

3. Select the Settings tab.

4. In the lower right settings filed labeled Chrome Settings, set the Barcode button to Off.
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5. Set the Auto Scan button to On.

Chrome Duo Settings
Barcode

Auto Scan

For information on the Auto Scan Workflow, see Section Auto Scan Workflow on page 31.

Barcode Scan Mode

With Barcode Scan Mode, XC allows the user to separate the registration process from the scanning process. The user
scans a barcode on a cassette, then registers the cassette to a specific patient and anatomic view. After the cassette is
exposed, the user can scan the cassette's barcode, and then insert the cassette into the bay to begin a scan.

Note:

Barcode Scan Mode is especially useful to facilities in which the x-ray generator and the scan unit are not
located within the same room.

To activate Barcode Scan Mode:

1. Click the Configuration button on the Patient Worklist screen.

Select the Admin tab.

Select the Settings tab.

In the lower right settings filed labeled Chrome Settings, set the Barcode button to On.

Ealb ol

Note:

When in Barcode Scan Mode, since the Auto Scan feature is always activated, the Auto Scan button is
disabled.

Chrome Duo Settings
Barcode Auto Scan

For information on the Barcode Scan Workflow, see Section Barcode Scan Workflow on page 35.

Configuration > Image Screen
Image Screen

Maximum Zoom Value

Sets the maximum value for the Zoom tool. Options are: 100%, 200%, or 400%.

Magnification Box Size

Sets the size of the Magnification tool as a value of total viewable size. Options are: 1/6, 1/4, 1/3, or 1/2.

Predefined Crop Boxes
The user can Add a new crop box size, Edit and Remove the existing crop box size here.
Adding a new crop box size:

1. Click Add.
2. Enter the width and height of the crop box.
3. Select the units.

© 2003-2014 Page 81 of 100 Doc # HC-XC-0028-05 Rev E-02
Confidential and Proprietary February 26, 2014
Property of iCRco, Inc.



| Configuration | 82

4. Click Finish to save the selected size.
Editing an existing crop box size:

Select an existing crop box size.

Click Edit.

Enter the required width and height of the crop box.
Select the units.

Nk W

Click Finish to save the selected size.
Removing a crop box size:

1. Select the crop box size that needs to be removed.
2. Click Remove.

Predefined Text Annotations

The Text Annotations tab allows the User to add a list of terms that can be automatically chosen when making a text
annotation on the image.

To add an annotation, click the Add button, enter the desired term, then click the Finish button.

To remove a term from the list, check the check box next to the desired term, then click the Remove button.

Configuration > Defaults

Defaults

The Defaults tab allows the User to predefine the Referring Physician and Institution names, so that when the User
is scheduling a patient, the only action needed is selecting the desired Referring Physician, Institution name and
Institution address, instead of having to manually enter the names each time.

Institution Address

Enter your facility's address in the text field. Click Close and Accept to save the changes. This will embed your
facility's address in the DICOM file.

Adding a Referring Physician/Institution

1. Navigate to Configuration > Defaults tab.

2. Click the Add button in either the Referring Physician or Institution section.
3. Enter the desired name.

4. Click the Finish button.

Removing a Referring Physician/Institution

1. Navigate to Configuration > Defaults tab.
2. Select the desired information to remove by click the check box next to the name.
3. Click the Remove button in the appropriate section.

Setting a Default Referring Physician or Institution

1. Check the box next to the desired default name.
2. Click the Set button. The entry will be set as the default selection.

XC Data Directory

This directory contains application data and preferences.
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To access the folder listed, the operating system must be configured to Show hidden files and folders.
Important:
Editing any of these files by hand will result in data loss!

The path to this folder is:

Windows XP:

C:\Documents and Settings\All Users\Application Datal\XC\

Windows 7:

C:\ProgrambData\XC\

Hardware Interfaces

XC employs the concept of an "interface" to visually represent the methodology of selecting scan parameters. For
each iCRco hardware product, there is one or more interfaces.

+ If there are multiple devices or a device with multiple scan functions (such as the Fusion DCR or Fusion DCR Flat
Panel), XC will show a tab for each device or scan function on the Scan dialog.

* ForiCR 3600, 3600M, 3600+, Chrome, and VertX, select a body part (from the skeleton graphic), Anatomy, and
View.

| Selected View: Scoli AP

- 0

iCRco CR iCRco iDR iCRco iDR-L
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* ForiDR, select the 14x17 inches button from the Scan dialog to initiate a scan.
| Selected View: Wrist R PA i

iCRco CR iCRco iDR iCRco iDR-L

.

J

» For iDR-L, select the appropriate "Region" from the Scan dialog to initiate a scan.

[ Selected View: Scoli AP

iCRco CR iCRco iDR iCRco iDR-1

Region ;

( Cassette ID
|

OO0

Domains

XC employs the concept of "domain" to distinguish between whatis being scanned. Domains also include processing
parameters, enabled in the Applications Interface.

To choose a domain, go to Configuration > Admin > Imaging Domain. See /maging Domain on page 76
XC has several domains:

*  Medical
* Mammography
* Veterinary

* Equine
* Podiatry
Medical

Medical is the default domain in XC. The Medical domain is aimed at general radiography.

Mammography

The Mammography domain shows a pair of breasts at the Anatomy Selection screen and relevant mammography sub-
anatomies. At the Scan Screen, the Mammography domain shows mammography sized plates: 18X24CM, 24X30CM.
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The Mammography domain changes at the following screens:

Veterinary

The Veterinary domain shows a pair of small animals at the Anatomy selection screen and remaps fields on the
Schedule Patient screen as appropriate for Veterinary.

The Veterinary domain changes at the following screens:
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Owner™*™

Pet Name Birth Date :
J | January n L 1 n | 2002 n
Breed

o h
— Patient Info ~

— Study Info -

Equine

The Veterinary domain shows a horse at the Anatomy selection screen and remaps fields on the Schedule Patient
screen as appropriate for Equine Veterinary.

The Equine Veterinary domain changes at the following screens:
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Owner™*™

Pet Name" HBirth Date ;
S | G - O . -
Breed

o A
— Patient Info ~

— Study Info ~
— m— |
March n | 7 n :zuu n (

B B~ B
\ b )
~ J

Podiatry

The Podiatry domain shows a foot at the Anatomy selection screen. It does not change other parameters.

The Podiatry domain changes at the following screens:
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Setting Up Modality Worklist Query

Double-click on the XC short-cut on the desktop to open XC.

In the Patient Information window, click the Configuration button.
In the Configuration window, select the DICOM tab.

In the DICOM tab, select the DICOM Setup tab.

Click the Add New AET button.

Enter the desired AE Title information, then click the Finish button.

To ensure that the new AE Title is valid, highlight the newly created AE Title in the List of known DICOM
AETs, then click the Test AET button. If the test is successful, continue to the next step. If the test is not
successful, please ensure that the AE Title information is correct, and try the test again.

8. Select the Worklist Inputs tab.
9. In the Worklist Inputs tab, put a check mark in the box(es) for the AE Title(s) you want query.

A A o o

OPTIONAL: The Modality Worklist Query can be set to query on a timer, and the query can be limited to Local
AET, Target Modality, or Today's date. To enable these features, select the desired query constraints from the
Query for new patients every drop-down menu or the Filter query by check boxes.

10. Click the Close and Accept button to save the changes.
Note:

For information on Querying a Worklist, see Section Querying a Worklist on page 70.

Creating a Procedure

Creating a procedure in XC requires an XC administrative account.
1. In the Patient List Window, click the Configuration button and select the Admin tab. Click Procedure to go the
to Procedure Configuration Window.

2. Enter the Procedure's name and ID, and click Add.
The procedure will be added to the list on the right.

Adding Views to a Procedure

3. Click on the procedure name in the Procedure List.
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4. Seclect the anatomy from the drop-down menu. This will open a list of views for the selected anatomy.

5. Drag and drop the view(s) onto the Procedure.
The view(s) will be added to the Procedure.

6. Save the changes by clicking Close and Accept.

Editing a Procedure

In the Patient List Window, click the Configuration > Admin > Procedure to go the to Procedure Configuration
Window.

» To add views to the procedure, click on the procedure name in the Procedure List.
Select the anatomy from the drop-down menu. This will open a list of views for the selected anatomy.
Drag and drop the view(s) onto the Procedure.

The view(s) will be added to the Procedure.
» To delete a procedure or view, click the Delete (red 'x') button positioned next to the procedure or view name.
» To edit a procedure's name, click on the pencil icon located to the left of the procedure's name and ID.

Adding Categories and Views

It is possible to add or remove anatomy and sub-anatomy categories using XC's Application Interface. For example, it
is possible to add a Lizard category to the Exotics anatomy type or add a Gecko view to the Lizard category.

Note:

The Exotic anatomy type is represented by an image of a bird.
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Opening the Applications Interface

1. Click the Configuration button on the Patient Worklist Screen.

2. Go to Admin. > Settings. In the Imaging Domain field, click the Launch Applications Interface button. The
Applications Interface will open.

Add Category

1. Open the Applications Interface.

2. Select the parent tree item that the new category will be placed under (e.g. Exotics).

3. Type the name of the new category in the text box. Click Add.

4. Click Save Repository to Disk. The new category will appear under the parent tree item.

Add View

1. Open the Applications Interface.

2. Select a category.

3. Type the name of the new view in the text box. Click Add.

4. Click Save Repository to Disk. The new view will appear under the category.

Note:
[ |

All views can have specific processing parameters applied to them. See Section Processing Parameter
Evaluation on page 90 for more information.

Processing Parameter Evaluation

The processing parameters can also be clinically adjusted and evaluated through the image preview functionality of
the App Manager. The purpose of this feature is to allow the user to adjust the processing parameter to their liking and
make the images better tailored to fit their specific needs.

Users can adjust the processing parameters to fit specific needs.

1. Click the Configuration button on the Patient Worklist Screen.

2. Go to Admin. > Settings. In the Imaging Domain field, click the Launch Applications Interface button. The
Applications Interface will open.

Select the appropriate library file in the combo box.
Select the appropriate imaging modality (e.g. Medical), anatomy (e.g. Chest), and view (e.g. AP Portrait).
Select the Processing option from the Project Params group in the second column of the window.

A

A list of the processing parameters will be displayed showing their current value. If you click the expanding arrow
on the right side of the window, you can select a patient, study, series, and image.

Selecting an image will load an image into the image preview window. Images in the image preview window can
be temporarily reprocessed with the parameters in the second column.

Note:
[ |

The images that will populate in this list originate from XC. If there are no images present in the list, this
means that there have been no images of that anatomy type and view acquired using XC.
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7. You may modify the processing parameters. If you do, click Process to reprocess the image.

Note:
You can maximize the window, zoom in, or use any of the provided image manipulation features like
Smart Box to evaluate the image.
Note:
|

Click Save Image to save the current images for comparison later.
8. After processing or saving an image, click the Comparison Tool button to compare the manipulated images side-
by-side.
9. Load the DICOM image into the Image Comparison Window by clicking Processed Image, Saved Image, Raw
Image, Gold Image, or Browse.

Note:
[ |

Clicking Processed Image will load the last images you processed, while clicking Saved Image will load
the last images you saved.

Note:

If you reprocess an image in the App Manager window, click Processed Image to reload it into the Image
Comparison Window.

Note:

The processing parameters used for each image during the comparison can be seen in the comparison
window by clicking View Processing Params.
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10. If needed, you can set an image to fill the whole screen by clicking the Maximize Image button. To view the
images in two separate windows, click the Split Windows button on the top, left side of the screen.

LnmDe el

11. Click Save Current Selection as Gold to store the image for image processing evaluation in the future. Images
stored this way can be retrieved later by clicking the Gold Image button.

12. Click Save Repository to Disk to save the image processing parameters.
Note:

Image Processing Parameter changes need to be clinically validated, either through the Image Comparison
Window or through the standard XC workflow.
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XC Help

Installing XC

These instructions describe how to install XC. USB drivers for iCRco hardware are installed automatically with the
installation of XC.

1. Insert the media containing the XC installer in the computer.
2. Double click Setup.exe to begin the installation process.
3. Click Next at the Welcome screen.

{i XC Setup i =] 3
1%

Welcome to the XC Setup Wizard

The Setup Wizard will install XC on your computer. Click Next
to continue or Cancel to exit the Setup Wizard.

Back: Cancel |

4. Check the box next to I accept the terms in the Licence Agreement, then click Next to continue.

18 XC Setup I =1 |
End-User License Agreement
Please read the following license agreement carefully .
TERMS RAND CONDITICNS OF 3
AGREEMENT
1 TERM

This Agreement commences on the

Commencement Date and expires on the
Expiration Date, unless terminated earlier in
accordance with this Agreement (the Term).

2 LICENCE
2.1 Grant of licence
On and from the Commencement Date, Licensor LI

¥ I accept the terms in the License Agreement!

Print | Back I Next I Cancel |

5. Click Next at the Custom Setup screen to continue.
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1%

Custom Setup ]
Select the way you want features to be installed, 3

Click the icons in the tree below to change the way features will be installed.

The necessary files to run XC.

B Q'| HC

Program Files

This feature requires 221MB on
your hard drive.

Browse,.. |

Reset I Disk Usage I Back Next Cancel I

6. Choose XC's data location. This is where XC will store images and patient data. Click Next to continue.

|_\!~‘ XC Setup =10l x]
Destination Folder
Click Mext to install to the default folder or dick Change to choose another. -
Install ¥C to:

Data location:

IC:\PrugramDatB\XC\

Change...

Back MNext Cancel

7. Click Next to continue.

iR XC Setup i =] 3
1%

select Additional Tasks |
Which additional tasks should be performed? -

Select the additional tasks you would like Setup to perform while installing XC,
then dick Next.

Additional Icons:

¥ Create 5 desktop icon |

Options:

¥ Place User Manual on the desktop.

¥ Place Quick Start Guide on the desktop.

Back Next Cancel

8. Click Install to begin the installation.
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iR XC Setup i =] 3
1%

Ready to install XC E/

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Cancel |

9. Please be patient while XC installs. Depending on the speed of the computer and available RAM, this process

could take a few minutes.

J=ES

Installing XC E/

Flease wait while the Setup Wizard installs XC.

Status:

Back [ext |

10. Click Finish to finish the XC installation.
=15

Completed the XC Setup Wizard

Click the Finish button to exit the Setup Wizard.

Biack Cancel

Device Specific Error
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Error Error Code
NONE 0x0000
UNKNOWN 0x0001
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Error Error Code
CANNOT LOAD USB CR DLL 0x0002
CANNOT LOAD USB CR FUNCTIONS 0x0003
USB DLL NOT LOADED 0x0004
SCAN STATUS USB INITIALIZE FAIL 0x0005
SCAN STATUS USB NO DEVICE ID 0x0006
SMALL EEPROM 0x0007
BIG EEPROM SETTINGS NOT SAVED 0x0008
MEMORY ISSUE 0x0009
USER CANCELLED SCAN 0x000A
INVALID SETTINGS 0x000B
MOTOR CONTROLLER ERROR 0x000C
THREAD ERROR 0x000D
INVALID CASSETTE SIZE 0x000E
PROCESSING PARAM ERROR 0x000F
SCAN_IN PROGRESS 0x0010
FOCUS IN PROGRESS 0x0011
PATH DOES NOT EXIST 0x0012
NO CR DEVICE ATTACHED 0x0013
UNKNOWN CR SETTING 0x0014
INT CR SETTING 0x0015
FLOAT CR SETTING 0x0016
BOOL CR SETTING 0x0017
NO DATA AQUIRED 0x0018
USB BOARD ERROR SLOW 0x0019
USB BOARD ERROR FAST 0x0019
USB BOARD ERROR FAST 0x001A
NO OEM CR CLASS CREATED 0x001B
DEVICE ID MISMATCH 0x001C
IDRL INVALID SCAN REGION 0x001D
INVALID EEPROM SETTING AT 0x0000 0x001E
USBICRCO DLL DOES NOT EXIST 0x001F
IDRL SENSOR NOT FOUND 0x0020
USER CANCELLED FOCUS 0x0021
IDRL USER CANCELLED MOVE TO REGION 0x0022
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Error Error Code

ERROR INVALID DEVICE SELECTED 0x0023

Adjusting MWL query filters

If after creating and setting the DICOM modality worklist target XC is not populated with worklist entries, the filters
may need to be modified.

MWL filters are contained in the Query Constraints text file located in the XC Public Directory. This directory
is discussed at the bottom of this document. In this file anything following a # is a comment an is ignored by the
application. The first twelve lines of the file are solely comments. Each additional line is a DICOM tag from the
MWL entry to be queried for. The tag line is format as:

Tag VR [<tag value>] # Comment

Any value present between the

[

and

]

of the tag line will act as a filter.

There are several tags inserted by the application when the MWL query is performed. These tags are list in the
comments on the top of the page. For most of these tags XC will insert a value between the square brackets to filter
the query results. For example, the tag:

(0040,0002)DA [] # ScheduledProcedureStepStartDate

will be given the current date so that only worklist items schedule for today are retrieved. Adding one of these tags
to the tag list will stop XC from adding the value on its own. This should be done if the customer does not want the
query to be filtered by these values.

In particular some worklists will use a default value for Scheduled Station AET where as XC will use the configured
local AET. This means a query will fail to return any items since the values don't match. If XC isn't being populated

by the worklist try adding the Scheduled Station AET to the tag list in QueryContstraints.txt. This tag will be placed

within the Scheduled Procedure Step Sequence.

Adding a Sequence tag and tags that belong in the Sequence

Sequences require at least four tags. First is the tag for the sequences itself. Then Begin Item and End Item tags for
each item in the sequence. Followed by the End Sequence tag. A Sequence can have multiple Items and an Item can
contain multiple tags. Though have only one Item with all relevant tags is fairly standard.

Example:
(0040,0100) sQ [] # Schedule Procedure Step Sequence (fffe,e000) - # Begin

Item # All tags that belong in this sequence should be placed here
(fffe,e00d) - # End Item (fffe,e0dd) - # End Sequence

List of Devices Supported by XC

This section provides a list of hardware devices supported by XC.
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Chrome Mammo Duo

Air DR

Name Cassete / Plate Size

3600 8 x 10 inches, 10 x 12 inches, 14 x 14 inches and 14 x 17
inches

3600 SF 8 x 10 and 10 x 12 inches

3600 M 18 x 24 cm and 24 x 30 cm

VertX 10 x 12 inches and 14 x 17 inches

Chrome 10 x 12 inches and 14 x 17 inches

Fusion DCR 10 x 12 inches and 14 x 17 inches

iDR 14 x 17 inches

iDR-L 14 x 51 inches

iDR-L 17" 17 x 51 inches

Vmotion AMX 10 x 12 inches and 14 x 17 inches

18 x 24 cm and 24 x 30 cm

14 x 17 inches
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Windows Help

Installing and Using the Microsoft Windows XP Input Method Editors

Installing the Desired Language

Note:
[ |

The User may need the Windows XP installation disk to install new languages.

Go to Start > Control Panel > Regional and Language Options.

Click on the Advanced tab.

In the section labeled Code page conversion tables, select the languages to install.
Click the Apply button to install the selected languages.

Pl ol S

Using the Windows XP Input Method Editor

1. In the Taskbar, right click, then select Toolbars > Language Bar. The Language bar will become visible in the
Taskbar.

2. Open the desired application.

w

Place the cursor in a text entry field in the application.
4. Use the Left Alt and Shift to toggle through the available languages.

Note:

Optionally the User may also left click on the language code in the Language toolbar to select from the
available languages.

Using Hotkeys with the Windows XP Input Method Editor

Table 3: Input Method Editor Hotkeys

Action Hotkey

Switch between languages or keyboard layouts left Alt+ Shift

When Japanese is the input language, select the Hiragana | Ctrl+ Caps Lock
character set

When Japanese is the input language, select the Alt+ Caps Lock
Katakana character set

Showing Hidden Files and Folders in Windows

The following instruction is applicable to both Windows XP and Windows 7.
1. Open My Computer, then click on Folder Options.
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2. In the Folder Options dialog, select the View tab.
3. Check the box labeled Show hidden files and folders, then click OK.
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